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Using Capital Plan 
Introduction 

Capital expenses are one of the least well-understood parts of establishing a budget. 
Annual expenses, which are sometimes referred to as an operating budget are predictable 
and can be easily tracked with a spreadsheet or other straightforward tools. Where things 
get more complicated are long-lived assets that don’t need replacement often – but when 
they do, they tend to be expensive. Ensuring that there are adequate funds to cover these 
costs is where Capital Plan comes in. 

It could be a car, a roof, or an appliance for an individual. It could be periodic maintenance 
or a replacement schedule for major assets in a condo association. Either way, you need to 
know how much to set aside each year in savings – typically referred to in an association as 
the capital reserve – in order to meet your long-term obligations. 

There’s a reason why community associations are required to do periodic reserve studies to 
protect their owners, but these depend on accurate and up-to-date information. Capital 
Plan acts like an ongoing study, making it easy to stay up to date and understand the 
impact of updated estimates, proposed new expenses, and the inevitable surprise that life 
brings all of us. 
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Basics: High Level Tour 
Capital Plan is a document-based application that organizes a complete capital expense 
budget into a single file. You can always rely on undo to reverse an unintentional change, 
and the app fully supports reverting to earlier document revisions using the File menu’s 
Revert To submenu to invoke Time Machine. 

Each budget consists of several functional areas separated into tabs: 

• The initial Expenses list is where you create and review assets or tasks, their schedule 
for replacement or completion, and their estimated cost. 

• Schedule visualizes the expenses in each of the budgeted years, graphically 
illustrating the cost for each established expense category as well as their total cost for 
the year. 

• Cash Flow provides a tabular look at each budgeted year below a graph that 
visualizes a key data point over time: percent funded.  This will typically be used to 1

experiment with different funding levels. 

• Funding illustrates what annual funding is required, not to cover the expenses of a 
specific year, but for the long haul. The total suggested amount is displayed and 
broken down by category. 

• Assumptions configure the budget period, effective rates, and other pertinent 
information specific to a particular budget. 

Each tab will be covered in depth in the pages that follow this overview. 

Getting Started 
Start by entering any expenses you know about, as everything else the app does depends 
on having expenses defined. Consider starting with just a few until you’re familiar with the 
app. 

If you have a lot of expenses to track and are comfortable with spreadsheets, consider 
reviewing Importing and Exporting Expenses under the Expenses section below. This can 
be a great way to hit the ground running with a comprehensive list of expenses. 

Next, review the Assumptions tab to set key parameters that affect your budget. At a 
minimum you should ensure that inflation rate, interest rate, and interest tax rate are set to 
reasonable values and establish your initial savings amount. 

 Percent funded is an important measure that is often poorly understood. See the % Funded Explained 1

subheading in the Cash Flow section for an explanation.
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Condo Tip: For condo associations, using a recent reserve study is the natural place to get started. 

Capital Plan is a Subscription Product 
Capital Plan is free to download and explore as a limited trial. To use it as intended 
requires an annual subscription that determines which features are available. Complex 
documents created at higher subscription tiers will open in view-only mode if required 
features are not included in the current subscription tier. 

Features that are only available at a specific subscription tier are indicated in the manual 
with one of these markers:  or . The Basic tier 
limits the total number of recurring expenses that can be defined, and higher tiers allow 
for longer-range forecasting. 

Subscription tiers and their features are fully documented within the application. Select 
the Capital Plan > Subscriptions… menu item to review features and pricing for each of 
the available tiers. 

Important Reminder: Financial Forecasting is an Educated Guess 
Don’t let the seemingly precise, definitive answers of any financial model fool you into 
thinking they’re a guarantee about the future. There are no guarantees about the future. 

Capital Plan takes the information you provide at face value and does its best to give you 
a forward-looking projection based on that information ... but it’s only as accurate as the 
assumptions you’ve made in providing a list of expenses, inflation rates, and so on. The 
resulting estimates do not constitute financial advice and should never be relied upon as 
the sole basis for making decisions. 

That’s not to downplay the value of this kind of forecasting exercise because it gives you a 
ballpark estimate to work with. The more you invest in refining your input as you learn 
more about your ongoing expenses, the more refined the output will be. Take every 
opportunity to ask vendors for updated cost estimates to keep as current as possible. 

Condo Tip: Aside from the value of the forecasting exercise itself and the board of director’s 
responsibility to maintain a healthy financial footing for the community, there’s an 
important secondary aspect of building this model: 

 Institutional memory. 

 With changing membership among the board of directors and employees over time, 
it’s extraordinarily valuable to document your history and capture information about 
your assets. Capital Plan serves triple-duty in record-keeping, project schedule 
reminders, and forward-looking financial projection. 

only in Plus and Complete only in Complete
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The Expenses Tab 
Each expense has its own row in the expenses table, whether it’s a physical asset to be 
replaced or a maintenance schedule for a durable asset. New expenses can be added by 
pressing the  button on the toolbar. This will create a new expense and start the editing 
process. You can also double-click on an existing row to edit it, or select the row and click 
the  button. Selected expenses can be deleted by clicking the  button, or by pressing the 
delete key. 

Individual expenses are defined by the following values available while editing: 

• Category is used to group related expenses and can be called anything you like. Terse 
terms are best, and an array of suggestions has been provided. 

• (Required) Name is the brief descriptive phrase that serves as a good reminder of 
what the expense represents. 

• (Required) Cost Estimate, Quantity, and Year of Estimate work together to estimate 
current and future pricing. The value used for forecasting is Cost Estimate times 
Quantity. This value is then adjusted for inflation from the Year of Estimate to the year 
the expense is anticipated. Tax is assumed to be included in the Cost Estimate. 

‣ All estimates are inflation-adjusted by default, but a custom inflation rate schedule 
can also be chosen as an advanced option. 

‣ When updating Cost Estimate, remember to update the Year of Estimate. 

• (Required) The Unit specified doesn’t affect how costs are calculated but acts as 
documentation to help with future quotes or estimates. Available units are Total, 
meaning the estimate is for the whole amount, Each for simple multiples of an item, or 
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a variety of specific measurements ranging from linear feet to 10-foot-by-10-foot 
roofing squares. 

• (Required) Life in Years is the amount of time expected between times when this 
expense comes due, also known as Useful Life in Years or Useful Estimated Life. This 
could be the anticipated life of a new asset, or the recommended time between 
inspections or other routine maintenance tasks tracked as their own expense. The 
expected lifetime of a physical asset should be somewhat conservative, as the 
expense can always be deferred if an inspection deems replacement unnecessary. 

• (Required) At least one of these two values must be specified in order to schedule 
expenses: 

‣ Year Last Paid documents when the asset was last replaced or the task was last 
completed. Future costs will normally be scheduled starting at Year Last Paid plus 
Life in Years followed by multiples of Life in Years thereafter. 

‣ Override Next can be used to change the year an expense is expected from the 
usual year-last-paid-plus-life-in-years timeframe. This can be used to move the next 
occurrence of an expense forward or backward in time without changing the 
normal expected life. It can also be used to schedule an expense for the first time 
when Year Last Paid is left blank. 

‣ Once a Year Last Paid date has been entered that matches or is later than the 
Override Next Year value, the override will be implicitly ignored. 

• (Optional) Sunset After can be used to limit the number of expense occurrences. 
Expenses will only recur until the first payment on or after the sunset year. 

‣ The Schedule drop-down to the right of the Sunset After field can be used to 
quickly review when this expense will be paid along with the future cost of each 
occurrence. Selecting any line from this list will set an appropriate sunset year, but 
just reviewing the list without setting a sunset year can also be informative. 

To dismiss the editor once editing expenses is complete click the  button, press the 
Escape key, or use the View > Hide Editor ⇧⌘H menu item. 

Tip: When multiple rows in the Expense table are selected the majority of editing features are 
disabled. The notable exceptions are the Category and Inflation Rate pickers which can be 
used to set these values for multiple selected expenses. 

Notes and Attachments 
When editing expenses, you’ll see three icons stacked vertically along the left side of the 
editing area. The topmost  icon represents basic expense details as described above, 
while the icons below represent free-form textual notes  and attachments  respectively. 
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Notes 

Notes are a great place to capture additional details about an expense. Everything from 
purchase history to preferred vendors to warranty information can be entered here. 
Once an expense has notes associated with it you’ll see a  icon on the right edge of the 
expense table’s Name column. 

 Notes can include searchable tags, consisting of a # symbol followed 
by any combination of alphabetic characters, dashes, and underscores. For example, 
you could use #review to mark expenses you intend to discuss during a review session 
and then easily find them using the corresponding tag search feature. 

Attachments  

Each expense can have files attached to it in the form of attachments. To add an 
attachment do one of the following: 

• Click the add photo button to browse your photo library and add photos 

• Click the add document button to browse your files and find an appropriate 
attachment. Supported types include images, PDFs, spreadsheets, HTML files, 
contacts, rich text files, and links to web sites. 

• Drag and drop an individual document into the area where attachments are 
shown. 

• Click in the area where attachments are shown and paste an image. 

Each addition results in a thumbnail that represents the attachment, with a visual 
preview for photos. Double-clicking on any thumbnail will open the attachment in an 
appropriate application. 

Attachments can be deleted by selecting their thumbnail and tapping the Delete key or 
using the Delete menu item under the Edit menu. 

Note: Attachments become a part of your budget document. They’re intended to be important 
reminders – not a full filing system for documents. Images will be automatically reduced in 
size and quality. Other documents are compressed but without loss in quality, so you will see 
a warning when they exceed 1 MB in size, with an absolute limit of 50 MB per attachment. 

Reviewing Existing Expenses 
The expense table offers a brief summary for each expense added to the budget: 

• The Status column is particularly useful. It shows when an expense is Due during the 
first budget year, Due YYYY specifying a later year, Overdue because it would 
normally have been scheduled in the past, or Past Sunset and no longer 
contributing to anticipated expenses. 

only in Complete

only in Complete
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‣ Double-checking status when making changes to an expense can be a good way 
to avoid a variety of mistakes. 

‣ Overdue entries should be reconciled by either updating their Year Last Paid if 
they have been addressed, or by using Override Next Year to reschedule them 
appropriately. 

In cases where an expense is incompletely defined or values contradict one 
another, the status column will show a warning symbol for its status. 

• Name identifies the expense and is actually a combination of the expense category 
[in square brackets] and its name. Icons will appear at the end of this column to 
indicate when an expense has notes or attachments. 

• Life shows the expected number of years between occurrences of this expense. 
When an expense has a Sunset After date its expected life will be followed by an 
orange sunset icon. 

• Last Estimate summarizes the Estimated Cost, Unit, and Quantity as appropriate (eg: 
“$22.00 x 140 ft2”.) 

The presence of this umbrella percentage icon indicates that the expense uses 
an advanced feature, tracking a custom rate schedule instead of inflation. 

• Total reflects the Estimated Cost times Quantity, inflation adjusted for the first 
budget year. This doesn’t indicate that an expense falls in this year, it merely serves 
as a common reference point for apples-to-apples comparisons between expenses, 
particularly relevant when sorting by this column. 

Sorting 
The expense table starts out sorted by Status, in descending order of urgency: 

• Incomplete or inconsistent expenses marked with a warning symbol. These may 
represent expenses that cannot be incorporated into the budget schedule, 
rendering it inaccurate. 

• Overdue expenses. These may need to be rescheduled, or they may have been 
taken care of but not recorded – in which case the budget schedule will be 
inaccurate. 

• Expenses due in the first budget year labeled as “Due” in green, followed by all 
other budget years in sequence labeled with “Due YYYY” in gray. 

• Expenses that have been sunsetted. These are expenses already paid on or after 
their established sunset year. They no longer represent any anticipated costs and are 
effectively ignored. They remain for historical reference. 
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The table can also be sorted by three of the four remaining columns: Name, Life, or Total. 
The Name column actually sorts by category and then name, conveniently grouping 
related expenses. The Last Estimate column consists of multiple types of information that 
have no natural sort order, making the Total column a much more natural way to sort by 
relative cost. 

Click on a column header to sort in ascending order. Click the same column again to flip 
to descending order. Click on the Status column header to return to the original sort 
order. 

Searching 
Type text in the search field to narrow the expense list to those that match. Descriptions of 
the matching criteria being considered will appear in a list below the search field: 

• “Name contains:” always shows up when search text is typed, ensuring that 
expenses whose names contain the text you type will be shown. 

• If category names contain the text typed, “Category is:” will indicate that expenses in 
the named categories will be shown. To avoid cluttering results, category criteria 
aren’t included when there are more than two matching categories. 

• To see expenses associated with a particular year, type just the year into the field 
and you’ll also see both “Due in YYYY” and “Last paid in YYYY”. 

•  Once you have added tags to expenses, you can find them by 
typing search text starting with #. “Tagged with:” criteria for all matching tags will be 
shown. 

Expenses matching any of the relevant criteria will be shown. 

Click on any one of these suggestions and it becomes required instead, eliminating the 
other possibilities from consideration. This requirement appears as an item to the left of 
the search field, and multiple requirements can be added. You can use the delete key or 
other text editing tools to remove these. 

Clear the search field by clicking the  icon at its right edge. This will remove both search 
text and any required search criteria you have added. 

Note: Once a “due in” requirement has been added, this guarantees that the only expenses shown 
are those due in a specific year. Taking advantage of this, the rightmost column will reflect 
the expense adjusted by inflation to that year instead of the first budget year. The column 
heading will be updated to reflect this (eg: “Total in 2029” instead of the usual “Total”.) 

 This doesn’t affect the Status column, which will continue to reflect the first year the expense 
is due as usual because each expense can be due in multiple years. For example, an expense 
due in both 2024 and 2030 will show up in searches for expenses due in 2030 – but its status 
will still show as “Due 2024.” 

only in Complete
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Importing and Exporting Expenses  
Some or all of a budget’s expenses can be exported for use in other applications by 
selecting the relevant rows in the Expense table, copying the data with the 
Edit > Copy ⌘C menu item, and then pasting the data into an appropriate application. 
The data is provided in tab separated value format, suitable for pasting into a 
spreadsheet. 

Similarly, tab separated data in either tab-separated or comma-separated form can be 
imported into a budget by selecting the Expense table and using the Edit > Paste ⌘V 
menu item. A file in this format with a .tsv or .csv extension can also be dragged into the 
Expense table to achieve the same goal. The application will attempt to analyze the data 
to make sense of it but may not always be able to determine what columns are present. 
Naming columns using the same terminology seen elsewhere in the app will improve 
your odds. 

Lastly, the menu items File > Import CSV/TSV... and File > Export TSV... provide another 
means for accessing the same functionality. Once exported, tab separated value files can 
typically be opened directly in spreadsheet applications for further manipulation. 

It’s worth noting that since copying and pasting use the same textual representation, you 
can use these features in several creative ways: 

• You can copy expenses from one budget and paste them into another. 

• You can import professional reserve studies by massaging their data into an 
appropriate tabular form in a spreadsheet and then copy and paste the data into 
your budget. 

• You can copy expenses and paste them into a text editor or spreadsheet to make 
changes and then copy and paste them back into your budget. You’ll see an ID 
column with a complex unique value for each expense when copying data out of the 
app. When pasting expenses into a budget, existing expenses with a matching 
identity will be replaced. If the ID column is absent or blank the imported expense 
will be added to those already present. 

Caution: The ability to copy and paste expenses includes only information that can be represented 
in text. It does not include attachments. To enable the final scenario described above, 
when pasting an updated version of an existing expense, any existing attachments will be 
automatically preserved. 

 It’s still worth exercising caution. To avoid loss, don’t build the habit of deleting expenses 
before pasting replacements. If you forget, just use undo to bring the original expense 
and its attachments back before you quit or manually save. 

only in Plus and Complete
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The Schedule Tab 
The expense schedule provides an overview of expenses that fall in each year. Stacked 
colored bars represent different expense categories that fall in that year, and a total for the 
year will be displayed to the right of the complete set. These values have already been 
adjusted for inflation from the estimates originally provided. 

A typical budget will forecast more years than can be displayed at once, so scroll down to 
see each year’s anticipated expenses. 

Longer bars will be labelled with the total cost of the category, and details can be seen by 
clicking once on any bar. The title text will change to reflect the specific selection, as shown 
below: 

 

You can click on this summary or double-click on any bar to see the individual expenses 
that contribute to this figure. The app will switch to the expenses tab and pre-configure the 
search field to show only related expenses. The Total column in the expense table will 
automatically change to reflect inflation-adjusted amounts for the year in question. 
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The Cash Flow Tab 
The cash flow analysis for your budget is presented in tabular form below a graph of a key 
indicator. The table presents the following information: 

• Year is the calendar year of each forecasted budget year. The first year and the 
number of years forecasted can be controlled on the Assumptions tab. 

• Savings is the amount of money you have set aside for tracked expenses at the start of 
the budget year. This might be a personal savings account, or it could be a condo 
association’s reserves account. 

• Contribution is the amount of money expected to be added to savings over the 
course of the year. Establishing savings targets is an essential part of ensuring that 
there are funds adequate to cover expenses in every year. 

• Expenses are the total of all expenses that fall in the budget year. These are deducted 
from savings. 

‣ To understand where this total comes from see the Expense Schedule tab, or click 
the magnifying glass icon beside the expense total. Clicking this icon will switch to 
the expenses tab with search pre-configured to show only expenses that 
contribute to this total. In doing so, the expense tables Total column will also 
reflect inflation-adjusted amounts for the year in question. 

• Interest - Tax reflects interest earned on savings, compounded monthly, on the 
average of savings at the start of the year and savings plus contribution less expenses. 
The interest rate used is defined on the Assumptions tab, as is the tax rate which will 
be automatically deducted from interest earned. 
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• Year End is the amount of savings available to start the subsequent year. This value 
comes from the year’s initial savings, plus contribution, plus interest after tax. 

• % Funded and Fully Funded are closely interrelated. The basic idea is that a fully 
funded figure represents the amount you should have already saved, assuming steady 
contributions, in order to be ready to pay every expense when it comes due. The % 
Funded figure is the fraction of this amount that your year-end savings represents. 

‣ If your immediate reaction is “I should always be 100% funded” then you’re not 
alone. That’s the obvious answer. It’s always safe ... but it’s also rarely necessary. 
See the section on % Funded Explained below for a more in-depth discussion. 

Tip: Savings and Year End figures will be shown in red whenever they’re below zero. 

Visualizing % Funded 
The graph above the cash flow table charts % Funded over time. Any time this graph 
reaches 0% it means your Year End figure is zero or negative for the corresponding year, 
so it’s a clear indicator that you need to examine your costs and contributions more 
closely. 

When the graph merely approaches zero it can still reflect cash crunch situations where 
the amount you need during the year to cover expenses has to be covered in part by 
contributions through the year, a situation that can suggest the need to investigate when 
in the year these expenses will occur and whether you’ll have funds available to cover 
them. 

The lines present on the graph illustrate the following: 

• The Fully Funded line in green marks the 100% funded level, while Zero Funds in 
red marks the opposite end of the spectrum. 

• The prominent solid blue line represents % Funded for each year. 

• Two faint solid lines represent the average and minimum % Funded levels. 

• The faint dashed blue line is a % Funded Trend which can make it easier to see 
whether your funding level is trending up or down when the actual value bounces 
around. 

‣ For the statisticians in the room, this line is a 2nd-order trend, a polynomial 
approximation of the underlying data. 

% Funded Explained 
If “fully funded” means you’ve saved everything needed for every expense by the time it 
comes due, then isn’t 100% funding the only rational course of action? It turns out it’s not 
that simple. 
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Having 100% of the required funds is really only necessary when every expense comes 
due in the same year. Under most circumstance you’ll have some money set aside for 
expenses that aren’t due yet, and it’s a time-honored practice to draw from these funds to 
pay for expenses due today. 

This amounts to borrowing from the future. 

Isn’t that dangerous and unsustainable? Not if properly managed. The good news is we’re 
never going to run out of future. There’s always more of it, and there's not even any 
interest to pay. The trick is ensuring that you’re sufficiently funded to deal with the “lumpy” 
nature of capital expenditures – and that you’re not getting progressively further behind 
until you run out of funds. 

Consider the following cash flow graph: 

 

There are three essential variables that impact your cash flow over time. It’s important to 
understand the role each one plays:  

• Savings. This is what determines your initial % Funded level. One-time adjustments 
to savings will tend to move the entire graph up or down without changing its 
overall slope. 

• Contribution. This determines whether your % Funded tends to get better, worse, or 
trend roughly flat over the long run. There will always be short-term ups and down 
any time you’re not 100% funded because you’re borrowing from the future and 
then paying it back over time – and trying to correct for this year-by-year with 
contribution changes is something of a fool’s errand. 

• Contribution Increase Rate. This controls whether the graph tends to follow an 
exponential curve upward, downward, or follow a straight line. Annual increases that 
don’t keep up with inflation will make the graph curve downward. Matching inflation 
will keep the general trend on a straight line (which might be diagonally up, down, 
or flat.) Increases at a rate above inflation will make it curve upward. 

So what does this graph tell us? 

Version 1.2.0 Page  of 13 31



Copyright © 2025 ThinkerSnacks LLC

A. In this instance we’re completely running out of funds around 2031, indicating that our 
overall funding level is definitely too low to act as an effective shock absorber against 
years with heavy expenses. Options to address this include a one-time addition to 
savings, finding a way to control expenses to stay out of the red, or adjusting 
contributions to attempt to trend upward to a % funding where we never bottom out. 

B. The graph is pretty flat according to the dashed trend line, so it suggests that the 
annual contribution amount would be sustainable with a higher initial initial savings 
amount. If it trended down you’d want to increase contributions (or reduce expenses.) 
If it trended above 100% you’d have an obvious opportunity to cut back on 
contributions. 

C. The dashed trend line isn’t strongly curved, and a quick check confirms that 
contributions are increasing at a rate matching inflation – which is appropriate for 
everything except brief periods of time as a tool to increase to contributions. 

Condo Tip: It may be tempting to try to make gradual changes to contributions over a series of 
years, but there’s no way for a board to dictate what future boards will do. It often 
makes more sense to “rip off the band-aid” and make appropriate corrections in a 
single year to put your finances on a healthy path – if you have high confidence in your 
expense forecast. 

How Much is Enough? 

Operating expenses, those due every single year for rent, insurance, payroll, services, or 
consumable items, tend to be relatively smooth and predictable. Capital expenses, 
those due periodically to replace or maintain assets tend to ebb and surge. Having 
many comparable expenses on their own unique schedules will tend to smooth our 
spending and reduce the % funding requirement, whereas having a few big-ticket items 
that dominate your expense calendar will tend to increase the required level. 

Every budget is a unique byproduct of its particular expenses, so there's no one-size-
fits-all guidance abut the “right” funding level. Exploring options using the Cash Flow 
graph and table as a guide will help you understand your budget and make a call that 
makes sense for you. 

Exploring Your Options 

Edit the first-year savings or contribution amounts to make immediate changes and see 
their impact without leaving the tab. The graph will smoothly animate when you press 
return or tab out of a field. 

Want some help finding a good starting point for your savings contribution? See the 
Funding section for its suggestion based on automated analysis of your complete 
budget. 
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The Funding Tab 
The Funding tab provides both general insight and actionable information about your 
budget. 

General Insight 
The graph shows what portion of your funding is associated with which expense category. 
While expenses can vary from year to year as a result of differing schedules, funding for 
eventual replacement remains relatively constant. 

As a result, this is a useful big picture answer to the question “where does my money go 
over the long run?” This contrasts with the Expense Schedule view which answers “what 
expenses are coming up in a particular year?” 

The  button displayed beside the overall funding recommendation will copy the amount 
shown to the clipboard. 

Clicking on a category will reveal the portion of 
recommended funding that comes from a given 
category. 

Clicking on these details or double-clicking on a 
category will switch to the Expenses tab with 
search preconfigured to show only expenses in 
that category. Click again on the selected 
category or outside the graph to remove the 
selection and show the overall funding 
recommendation again. 
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% Target 
The value shown below your % Target is a great starting point for determining an 
appropriate annual supplement to savings.  Funding at the level shown with annual 2

increases matching inflation will result in savings that tend toward the target % funded 
figure.  Clicking on the % Target title will offer alternatives in 10% increments, while finer 3

adjustments can be made on the Assumptions tab. 

Note: Contribution increases will match inflation by default and indeed this is usually your best bet. 
If you’ve chosen a custom contribution increase rate the amount recommended will take that 
into account. 

 If you get an absurdly low recommendation? One that curves upward strongly on the Cash 
Flow tab? Check to make sure you don’t have open-ended contribution increases at a rate 
above inflation. These will also make it impossible to target a % funded level without periodic 
corrections. 

Keep in mind that your starting point is important, no matter how high your % funded 
target is. While not fully funded you’ll see the impact of borrowing from the future: 

• Years where expenses are greater than average will move % funded away from fully 
funded. 

• Years where expenses are less than average will move % funded toward fully funded. 

This effect is progressively more pronounced the lower your funding rate is. Within the 
recommended range it will average out over time, but exhausting your savings, even 
briefly, is still a very real problem to be avoided. 

While running out of funds is clearly not the way to balance a budget, there is no single 
“correct” funding level. Pick what looks like an appropriate target and experiment using 
the tools available to find a funding strategy that meets your goals and obligations while 
respecting your constraints. 

 Keep in mind that the target value shown is inclusive of interest. The actual contribution rate you set 2

should take this into account.

 Over a shorter budget period you’ll see gradual change in funding levels, but it can take quite a while 3

to reach the funding target – and at anything other than 100% there will still be year-to-year variability. 

 The recommendation takes into account all costs and incremental funding needs over the budget 
period, so it’s reasonably resilient in the face of one-time or similar expenses with a sunset date. Even 
so, these can make it impractical to pick a single inflation-adjusted contribution rate spanning many 
years.

Version 1.2.0 Page  of 16 31



Copyright © 2025 ThinkerSnacks LLC

 

The Assumptions Tab 
There are no global settings that affect all of your budgets. Instead, each budget document 
can be configured independently in a way that suits its purpose. There are four areas that 
can be configured, each of which is described below. 

You’ll normally come back to these values once a year to establish a new budget period 
and review everything to make sure it’s as accurate as possible. 

Budget Period 
The First Year and Total Years values define the budget period used for all of the analysis 
tools and visualizations. They can be changed at any time to explore different scenarios as 
this change is non-destructive; the budget period is used purely for analytical purposes. 

New budgets start out with the current year and a 30-year span as their default values. 

Common Rates 
Inflation is used to predict future costs for expenses and is compounded annually. It’s also 
used to bring out-of-date estimates up to date by applying retroactive inflation to an 
estimate from last year – or last decade. Getting revised estimates is always best, but this 
feature can help fill gaps in your knowledge until revised estimates are available. 

Interest on Savings is used to compute interest. It is specified as an annual rate of return, 
but is compounded monthly on the average anticipated savings during a year. In cases 
where savings are distributed across multiple accounts or investment styles, this should 
be a blended rate that can be applied to savings as a whole. 

Tax Rate on Interest is used to estimate taxes to be deducted from interest and is 
specified as an annual percentage of interest paid that will be due in taxes. Non-profit 
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organizations like condo associations are exempt from many taxes, but this is often an 
exception. Some research may be required to set this to an appropriate rate. 

By default, Inflation is set to 3% and both Interest and Tax rates are set to 0%. Typing in a 
new value will update the entire budget model to reflect the new rate. As an advanced 
option you can also add additional rate periods to define a rate that varies over time. 

Savings for Capital Expenses 
The cash flow analysis needs to know both the starting point for savings, and some idea of 
what contributions will bolster savings over time. This section defines defines the currency 
used for all amounts alongside values the app needs to analyze your situation: 

• Amount in Savings is the literal liquid assets available – or that will become available 
in the case of bonds or similar investments – at the start of the first budget year to 
cover anticipated expenses. It may be necessary to estimate this amount for 
budgeting purposes. Be sure to account for outstanding obligations. Accounts 
payable from the preceding year that have not yet been paid should be deducted to 
accurately reflect the funds available for expenses beginning in the first budget year. 

• Annual Contribution is the amount that will be added every year to savings, 
assumed by default to be increased each year to match inflation. 

‣ As with individual expenses, custom inflation rate schedules are supported but 
should be used with care. It’s not uncommon to plan to increase contributions 
gradually to hit a target.  Return to matching inflation as rapidly as possible – and 4

consider using a rate that varies over time to model this plan (eg: 8% increases 
for each of the next four years, then reverting to the same rate as inflation.) 

•  One-Time Contribution is an amount that will be added 
during the first year of the budget. It will normally be zero, but can be used to record 
special assessments or loans for condo associations.  

Definition of Fully-Funded 
The basic idea is that a fully funded figure represents the amount you should have already 
saved, through regular contributions to savings, in order to be ready to pay every expense 
when it comes due. 

The amount required is determined by starting with a cost estimate, which is then 
adjusted for inflation using the rate provided. It’s essential that all expenses be accounted 
for, that estimates are kept up to date, and that both the estimates and inflation rate 
provided are as good an approximation as is practical. 

only in Plus and Complete

 The wisdom of these plans is debatable. It makes sense in a growth context, but trying to soften bad 4

news in a condo complex is problematic and can backfire.
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A specific example can help ground the discussion below, so consider a car that costs 
$35,000 in 2020 which is assumed to have a ten-year useful life. Assuming 3% inflation, it 
would cost $47,037.07 to replace in 2030, and $63,213.89 to replace again in 2040. There 
are multiple reasonable approaches to meeting this goal controlled by the Funding Style 
and Funding Timeline settings. 

None of these options change the target amount at the time of purchase. They only 
change the strategy for saving to reach that goal. They have no impact on your actual 
savings from year to year. They only impact how the % Funded figure is computed as a 
rough guide to the health of your savings over time, so it’s fine to leave these at their 
default values and not worry about the details – unless you’re curious. 

The Funding Target figure is a % target used by the Funding tab for analysis 

Advanced Option: Funding Style 

It’s easiest to see the difference between the three styles offered in Capital Plan with a 
concrete example. Here’s the annual increment in “fully funded” savings for an asset that 
will cost $20,000 in ten years time, and then $26,878.33 in another ten years, reflecting 
3% inflation: 

  Equal Amounts Inflation Ramp Moving Target 
 Year 1 $2,000.00 $1,744.61 $1,532.83 
 Year 2 $2,000.00 +3% = $1,796.95 +6.0% = $1,624.80 
 Year 3 $2,000.00 +3% = $1,850.86 +5.9% = $1,720.91 
 Year 4 $2,000.00 +3% = $1,906.38 +5.8% = $1,821.32 
 Year 5 $2,000.00 +3% = $1,963.57 +5.8% = $1,926.21 
 Year 6 $2,000.00 +3% = $2,022.48 +5.7% = $2,035.76 
 Year 7 $2,000.00 +3% = $2,083.16 +5.6% = $2,150.14 
 Year 8 $2,000.00 +3% = $2,145.65 +5.6% = $2,269.55 
 Year 9 $2,000.00 +3% = $2,210.02 +5.5% = $2,394.19 
 Year 10 $2,000.00 +3% = $2,276.32 +5.4% = $2,524.27 
 Year 11 +34.4% = $2,687.83 +3% = $2,344.61 -18.4% = $2,060.00 
 Year 12 $2,687.83 +3% = $2,414.95 +6.0% = $2,183.60 
 Year 13 $2,687.83 +3% = $2,487.40 +5.9% = $2,312.76 
 Year 14 $2,687.83 +3% = $2,562.02 +5.8% = $2,447.71 
 Year 15 $2,687.83 +3% = $2,638.88 +5.8% = $2,588.67 
 Year 16 $2,687.83 +3% = $2,718.05 +5.7% = $2,735.89 
 Year 17 $2,687.83 +3% = $2,799.59 +5.6% = $2,889.61 
 Year 18 $2,687.83 +3% = $2,883.57 +5.6% = $3,050.09 
 Year 19 $2,687.83 +3% = $2,970.08 +5.5% = $3,217.60 
 Year 20 $2,687.83 +3% = $3,059.18 +5.4% = $3,392.41 

They all add up to the same total in the purchase years: year 10 and 20. They just 
distribute that amount differently during the years leading up to an expense. Equal 
Amounts requires heavy funding early, yielding lower % Funded numbers, while Moving 
Target underestimates funding requirements to yield higher % Funded numbers. 
Inflation Ramp strikes a balance between the other alternatives and guarantees a 
gradual increase in the contribution required to match inflation. 
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Conclusion: These are all valid strategies for accumulating required savings over time, so any of 
them are viable. It comes down to a difference in philosophy, and you’re welcome to 
choose any style that suits your needs. Capital Plan suggests Inflation Ramp as the least 
erratic and therefore most predictable over time, but you may prefer to use a style that 
matches what an outside agency uses in reports they provide. 

In more detail: the most straightforward asset funding model assumes equal 
contributions over the useful life of an asset. In the example above you’d set aside 
$4,703.71 each year after the original purchase to fully fund the first replacement. You’d 
then set aside $6,321.39 each year in the following decade to fully fund the next 
replacement. This is how the app will behave when Funding Style is set to Equal 
Amounts. 

This approach has two subtle issues, both rooted in inflationary pressures. That sudden 
switch in the amount you need to save once a decade? It only gets worse with longer-
lived assets. Consider an asset with a 30-year useful life at 3% inflation. Each time it’s 
replaced the annual funding suddenly jumps to 2.43 times as much. This can affect the 
schedule in unfortunate ways: 

• Adjusted for inflation, putting aside the same amount in year one is a harder pill to 
swallow than in year thirty. Getting hit with a decade of inflation all at once is 
painful, and two or three decades is significantly worse. 

• When the amount you need to set aside suddenly jumps, the fact that the prior 
funding level is woefully insufficient may come as an unwelcome surprise. 
Correspondingly, in years when the amount stays flat it may give the appearance 
that planning for increased funding isn’t necessary. 

If you have enough expenses on different timetables it may not matter as much because 
some will be early in their funding cycles and others will be late. In theory, it can all 
average out. In practice, your largest expenses tend to be long-lived assets that can 
have an outsized impact on funding requirements. 

As a result, studies sometimes omit very long-lived assets, or under-estimate their 
lifetimes to avoid undue pressure early on. Capital Plan has its own alternative: the 
Inflation Ramp funding style guarantees a smooth, inflation-matched funding strategy. 
This is the default mode for new budgets. 

The approach computes a contribution amount that goes up at a rate exactly matching 
inflation – while still guaranteeing two important things: 

• The sum of these contributions still adds up to the amount required to cover each 
expense. 
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• There’s no discontinuity at any point. Contributions the year after a replacement 
continue the same smooth inflation-based slope as contributions leading up to the 
replacement. 

Example: Using the car example, you set aside $4,103.07 the first year and increase this amount 3% 
each year for a final contribution of $5,353.57. You still get exactly $47,037.07 in one 
decade. Then you start saving for the next with $5,518.14 and all the math works out for 
that replacement, too. We’ll wait here if you want to double-check these numbers. 

The final funding style is the way many reserve studies are prepared. Moving Target 
addresses the issues described above for Equal Amounts by using funding proportional 
to the current cost each year of an expense, an amount which increases over time. This 
allows early payments to be smaller, which is attractive, but it means that subsequent 
years require not merely paying for an additional year’s depreciation – but also catching 
up on the additional inflation missing in every prior year’s contribution. 

This approach results in fully funded figures that grow faster than inflation, followed by a 
significant downward correction after each purchase year. While the strategy is often 
presented as if it’s putting aside equal amounts each year, in practice this is far from the 
case as you can see in the table above. 

Advanced Option: Funding Timeline 

There can be reasonable differences of opinion about when an expense needs to be 
completely funded. You have two options: 

• Year of Expense schedules the first contribution for a subsequent expense the 
year after an expense is incurred. The full amount for the next expenditure will then 
be available at the end of the year the next expense lands in. 

• Year Before Expense schedules the first contribution the same year an expense is 
incurred. The full amount for the next time will then be available at the start of the 
year the next expense lands in. This is the default setting for new budgets. 

The Year Before Expense setting can help to avoid cash crunch situations when outsized 
expenses land earlier than the contributions required to cover them. In practice the 
difference is usually subtle with a large number of expenses on different timelines. 

Advanced Feature: Custom Inflation Rates  
By default, all expenses are assumed to increase over time following whatever inflation 
rate is set for your budget as a whole. 

You have another option in instances where you know a particular product or service is 
contractually guaranteed to follow a different increase schedule, or where historical or 
geographical norms suggest another rate. Every amount affected by inflation includes a 

only in Plus and Complete
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rate picking control which initially displays “+ Inflation” to indicate that inflation is applied 
to this value: 

 

In addition to being able to select “No Inflation” you may define and name any number of 
additional rates. This simplifies setting up an unusual rate structure and applying it to 
multiple expenses: once you’ve set up a rate and have given it a name, you may pick the 
name from this list for any applicable expense in the same budget. 

Named rates work like any other rate and may vary over time. 

Advanced Feature: Rates That Vary Over Time  
You may have noticed the indicator to the right of each rate field labeled “every year”. 
Using a single rate for all years is often sufficient - but there may be times in a 
sophisticated budget when more control comes in handy. For example, if interest rates 
are unusually high there may be an expectation that they’ll come down after a few years. 
That’s what this feature is for. 

Initially, a newly created rate is the same in every year, past and future,  and can be edited 5

easily by typing a new percentage figure in the text field provided: 

 

The “every year” indicator tells you what range of years this applies to, which will always 
be the defined period of years that includes the first year of the current budget. In a more 
complex example you might see the something like the following: 

 

Typing a new rate here affects every year starting with 2021. Inflation rates are used to 
adjust costs from the prior year, so a 3% rate in 2021 means that a cost estimate from 
2020 will be 3% greater the year following. 

There are four possible naming patterns that can be shown for a rate period: 

• every year states that there is only a single rate period, one percentage value that is 
applied to each year. 

• through 2025 states that this is the first rate period, but that another one begins in 
year following. 

only in Plus and Complete

 Defining inflation rates for the past may seem peculiar, but they’re used to make educated guesses 5

about out-of-date cost estimates. You might have recorded the price you paid for an asset a decade 
ago and haven’t gotten around to getting a new estimate, bid, or quote. This allows the app to use an 
approximation until a newer cost estimate can be provided.
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• in 2023 and in 2022-2025 both state 
that there are earlier and later rate 
periods, and describe the year or years 
that this specific rate is effective. 

• starting 2029 indicates that this is the last 
rate period, that the percentage 
specified applies to the year named and 
every subsequent year. 

As hinted at by the downward caret, you can 
also click on the description of this period to 
see values for all periods. This list includes the 
option “Edit Rate Periods...” to make more 
complex adjustments as described below. 

Editing Rate Periods 

Rates are defined by a series of rate periods, each consisting of a percentage to be 
compounded annually during a range of years. All except the first period specify a 
starting year, and all but the last will implicitly end the year prior to the next in 
chronological order. 

To create the example shown here, you’d start with a 4% rate for every year and add two 
additional rate periods: one starting in 2020 with a rate of 9%, and another starting in 
2021 with a rate of 3%. It doesn’t matter what order rate periods are added in. You could 
just as easily add the 2021 rate of 3% first, followed by the 2020 rate of 9%. 

Add a new rate period by entering a Starting In year and Rate, then press the Add button. 
An existing rate period can be changed by selecting it from the period table, editing the 
starting year and/or rate, and pressing the Change button. The Change button will be 
disabled when the change doesn’t make sense, such as when more than one period is 
selected, no period is selected, or when attempting to change the starting year of a 
period to be identical to the start of another period. 

The Delete button can be used to delete periods selected in the table shown, but it will 
never allow all rate periods to be deleted. One period must remain to ensure that there is 
always an effective rate defined. 
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Printed Reports  
For an individual user, Capital Plan’s interactive features provide the most natural way to 
explore the elements of a capital budget. For group review or archival purposes it may be 
more convenient to provide PDF or paper reports. 

Expenses 
When the Expenses tab is selected, the 
File > Print... ⌘P menu item will print a 
list of expenses. It will respect the 
current search criteria and sort order by 
default, which can be disabled with a 
checkbox on the print panel. 

The information presented is similar to the presentation in the expense table with the 
notable exception of the final column. Unlike the interactive table the, the final column will 
display the “Next Due” cost for each expense unless the report is sorted by cost. 

Schedule 
When the Schedule tab is selected, the 
File > Print... ⌘P menu will print a year-
by-year itemized list of categorized 
costs. 

This is much more detailed than the 
graphical summary presented on the tab 
since it lacks any of the interactive 
features. The complete timeline makes 
an informative PDF to distribute or 
archive, but when physically printed for distribution you may want only the first five or ten 
years. The number of years to be printed and maximum number of lines from notes can 
be customized on the print panel. 

Cash Flow 
When the Cash Flow tab is selected, the 
File > Print... ⌘P menu item will print the 
full cash flow analysis. 

The presentation is similar to the tab, 
with a graph covering every year of the 
budget period at the top of the first 
page, followed by year-by-year details 
spanning as many pages as are 
required. 

only in Complete
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Community All Expenses by Status

Status Expense Life Last Estimate Next Due

Due Amenities Fitness center allotment 3 $10,000.00 $10,300.00

Due Electrical Miscellaneous electrical systems expenditures 5 $150.00 × 25 $3,862.50

Due Exterior Building envelope inspection using swing stage or Boson's chairs 5 $18,000.00 $18,540.00

Due Exterior Re-stain and re-finish wood rail caps 5 $15,000.00 $15,450.00

Due Exterior Replace urethane caulking around windows and at control joints 10 $16.90 × 3,400 ft $59,183.80

Due Fire Safety Dry system fire sprinkler air compressor replacement 15 $1,500.00 $1,545.00

Due HVAC Replace HVAC system software and management equipment update 10 $4,000.00 $4,120.00

Due Plumbing Miscellaneous plumbing systems expenditures 5 $300.00 × 25 $7,725.00

5

5

5
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5
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5
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Community Cash Flow

Annualized Rate Assumptions

+3% Contribution +3% Inflation 0% Interest 0% Tax on Interest

%
 Fund

ed

2024 2026 2028 2030 2032 2034 2036 2038 2040 2042 2044 2046 2048 2050
0%

25%

50%

75%

100%
Fully Funded

Average 39.0%

Minimum 13.5%

Year Savings + Contribution - Expenses + Interest - Tax = Year End % Funded Fully Funded

2023 $100,000 $140,000
+ $300,000

$161,514 $0 $378,486 33.5% $1,128,400

2024 $378,486 $144,200 $7,426 $0 $515,259 40.3% $1,279,184

2025 $515,259 $148,526 $117,206 $0 $546,580 41.3% $1,324,935

$546,580 $688,306

$688,306 $766,467

$766,467 $826,973

$826,973 $603,569

$603,569 $759,283

$759,283 $936,631

$936,631 $1,004,394

$1,004,394 $727,370

$727,370 $176,916

$176,916 $342,746

$342,746 $537,752

$537,752 $642,794

$642,794 $716,887

$716,887 $160,534

$160,534 $357,884

$357,884 $413,404

$413,404 $513,503

Community Expense Schedule

2025 $136,329
Interior $103,000
$66,875 Recarpet common areas that have carpet

Everyone is sick of the brown carpets. Make sure the spiff committee comes up with an option 
that has widespread support.

$36,126 Paint interior of common areas

Amenities $10,927
$10,927 Fitness center allotment

Site $8,742
$8,742 Miscellaneous concrete flatwork repairs
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Funding 
When the Funding tab is selected, the 
File > Print... ⌘P menu item will print the 
funding analysis. 

As with the Schedule report, this 
presents much more detail than the pie 
chart representation since it lacks any of 
the interactive features. It includes 
descriptive content intended to help 
newcomers understand the implications 
of funding at a range of levels: 

• Cover Average Costs, which trends toward 0% funding 

• Full Funding, which trends toward 100% funding 

• Established Target, which only shows when set to something other than 0% or 100%, 
as these would be identical to either the Cover Average Cost or Full Funding figures 

• First-year Funding, reflecting the actual contribution determined for the first year of 
the budget, including interest 

Below these summaries, a category-by-category chart indicates how much funding would 
go to each category in the idealized scenario. 

Important: It’s critical to understand that the funding levels described trend toward the 
corresponding % funding over the very long term, and that dips and surges are 
unavoidable below 100% funding. Periods of higher than average costs can temporarily 
depress % funding while also reducing interest as a factor in funding. Always use the 
Funding analysis in conjunction with Cash Flow analysis to anticipate shortfalls and to 
act before savings are depleted. 

Printing Combined Reports 
It can be convenient to print a collection of all relevant reports in a single document. 
Regardless of the selected tab, the File > Print Full Report... ⇧⌘P menu item will compile 
the reports for each tab with sequential page numbering. 

The default setting for the Funding section of the full report shows the first five years 
without notes, but this can be adjusted to taste using settings on the print panel. The 
Expenses Report in this collection includes all expenses sorted by category and name 
regardless of the current interactive view. 

Also printable: Comparison to Baseline 
See the Reviewing Changes section for one additional form of printed output. 
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Community Funding Summary

Analysis of 2023 contribution derived from current estimates and assumptions

Cover Average Costs

$121,806
Trends Toward 0% Funded

Ongoing funding at or below this level is not 
sustainable. It will cover costs in average years 

but will not increase savings, which will be 
exhausted by above-average years as inflation 
erodes purchasing power. At this funding level 
it's not a question of if you will need additional 

funds, but when.

2023 Funding

$140,000
Trends Toward 57.2% Funded

Consists of a $140,000 planned contribution.

Will tend to increase % funding from year-end 
estimate of 33.5% funded.

Full Funding

$153,603
Trends Toward 100% Funded

Continuous funding at this level is not strictly 
necessary as the only time full funding is 

required is when every recurring expense lines 
up in the same year. The Cash Flow analysis can 

be used to determine a sustainable funding 
target.

Category Full Funding % of Total

Amenities $3,641 2.4%

Electrical $1,397 0.9%

Elevators $20,862 13.6%

Exterior $29,125 19.0%

Fire Safety $2,437 1.6%

HVAC $32,193 21.0%
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Reviewing Changes  
Capital Plan can describe the difference between a historical baseline and the current 
document by describing the expense additions, deletions, and edits that have taken place. 
It will also help visualize the difference between the current cash flow projection and a 
baseline derived from a historical snapshot. 

Features related to these activities are all grouped under the Compare 
menu. Each task requires a reference point, and Capital Plan enables this 
with two different kinds of historical snapshots: 

• Recording a temporary snapshot helps with short-term comparisons 
as when trying out “what if” scenarios. It will be discarded when the 
document is closed.  

• Adding a named snapshot creates a persistent historical record as 
part of your document that will be preserved alongside subsequent changes. This can 
be done at any meaningful time, ideally at least once a year when the capital reserve is 
reviewed for annual budgeting purposes, and can be given a memorable name. There 
is no fixed limit to the number of historical snapshots you can record and name. 

Creating and Managing Snapshots 
The Make Temporary Snapshot menu item will 
create an unnamed snapshot that is always at 
the top of the list of snapshots in the Compare 
menu called “Temporary Snapshot.” If a 
temporary snapshot has been created during 
the current session this menu item will be 
renamed Update Temporary Snapshot. 

The Manage History... menu item opens a sheet with everything required to add, rename, 
and delete named snapshots. Snapshots added by pressing the Add button capture the 
current state of every expense, automatically record the current date, and prompt for a 
unique name. 

Adding Backups as Snapshots 

If you forgot to create a snapshot but have access to an earlier backup copy of your 
document, you can use the older document to create a new snapshot: 

• Open the current document 

• Select Manage History... from the Compare menu 

• Drag the old document from the finder into the list of snapshots, and a snapshot 
will be created automatically using the name and timestamp of the backup 
document 

only in Complete
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Selecting a Snapshot 
Once created, snapshots can be selected from the Compare menu, which will show a 
checkmark beside the currently selected snapshot. Picking the selected item again will 
deselect the snapshot. 

The current selection will dictate the behavior of the various comparison features 
described below, each of which will treat the selected snapshot as the comparison 
baseline. 

Exporting a Comparison 
While the printed form is certainly the easiest to read, there are times when exporting a 
list of additions, deletions, and changes can be useful. The menu item Export Comparison 
as TSV... will create and open a tab separated value file containing one line for each 
addition or deletion, and a pair of “before” and “after” lines for each changed expense. To 
assist in focusing on the specific changes, columns with data that is unchanged will be left 
blank. 

If no snapshot is currently selected, Capital Plan will prompt for another .budget 
document to use as the comparison baseline. This can be useful when comparing with a 
backup of the original document. 

Printing a Comparison 
The menu item Print Comparison Report... 
produces a printed document more suitable 
for manual review. It serves as a convenient 
reminder of changes that have been made 
over time, neatly separated into sections 
with additions, deletions, and changes. 

If no snapshot is currently selected, Capital 
Plan will prompt for another .budget 
document to use as the comparison 
baseline. This can be useful when comparing with a backup of the original document. 

When an expense is changed, the affected columns will show a grey value in a smaller 
font above the new value to illustrate the change and emphasize the current value. Values 
that are unchanged are also displayed in grey with the exception of the Category and 
Name columns which are left black for legibility. 
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Visualizing Cash Flow Changes 
Whenever a snapshot is selected, the graph on the Cash Flow tab will be augmented with 
a faint line representing the earlier cash flow: 

 

Creating a temporary snapshot can help visualize the impact of changes made during a 
session by referring back to the Cash Flow tab periodically. 

The snapshot of a cash flow will reflect any and all changes made, including inflation rate 
changes, funding levels – even changes in the strategy used to compute % funded. It will 
cover the same number of years as the original snapshot, so don’t be surprised if it 
doesn’t cover the exact same years as the current document.  A five-year old snapshot 
covering the same number of years will end five years before the newer analysis. 

By default, the printed Cash Flow report will also include this faint reference line for any 
active comparison. The Full Report will normally omit the comparison. These default 
assumptions can be changed from the print panel by toggling the relevant checkbox. 
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Currency Considerations 
Capital Plan associates a specific currency with each document, starting with the default for 
your selected region when creating a new document. All values are explicitly entered and 
displayed in this common currency. This should feel natural under most circumstances and 
behave like any other application. 

It gets slightly more nuanced when a document is created in one region and opened in 
another. In this situation display will be treated as a foreign currency represented using 
local conventions. See below for several examples: 

This ensures that habits for a user in a specific locale work across documents regardless of 
currency. In the United States or United Kingdom you could type “1,000” to enter a value of 
one thousand regardless of the document’s currency, while in Germany you can type 
“1.000” to enter the same value. This is also true for importing CSV or TSV content from the 
clipboard or a text file. Values will be interpreted per the local conventions according to the 
system’s selected region. This facilitates copying and pasting from another app running on 
the same system. If any currency symbols are present when importing or pasting expenses 
these must match the document’s currency. 

Changing a Document’s Currency 
The Assumptions tab displays the currency used by a document and can be used to 
change this setting. This does not imply any kind of exchange rate but merely changes the 
currency symbols used on screen and in print. 

Created In

United States United Kingdom Portugal or Germany

Viewed In

United States $1,000.00 £1,000.00 €1,000.00

United Kingdom US$1,000.00 £1,000.00 €1,000.00

Portugal 1000,00 US$ 1000,00 £ 1000,00 €

Germany 1.000,00 $ 1.000,00 £ 1.000,00 €
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Frequently Asked Questions 
Q: Can Capital Plan ask before saving changes? 

A: Yes. Modern applications on macOS default to auto-saving documents, but this can be 
changed system-wide if you prefer to see a 
prompt before changes are saved. 

 You’ll find this setting in Apple’s Settings app 
under the Desktop and Dock category. 
Scroll down to find the Windows category 
where there’s a setting labeled “Ask to keep 
changes when closing documents.” 

 Turn this on and Capital Plan will start asking 
for permission to save when you close your 
documents. 

Q: If I’ve accidentally saved changes, is there a way to get my old document back? 

A: Possibly. Older versions of your budget document may be preserved by Time 
Machine, space permitting, even if you haven’t backed up to an external disk. The File 
menu includes a Revert To submenu with the option to Browse All Versions... that will 
let you view the contents of all available prior revisions before picking one to revert to. 

Q: Why doesn’t my cash flow match exactly what a professional reserve study 
shows? 

A: The year-by-year expenses and contribution can typically be aligned by setting 
inflation assumptions correctly  and ensuring that all expenses have the appropriate 6

Estimated Cost and Year of Estimate, and that the same expense schedule is implied 
by Life in Years and either Override Next or Year Last Paid. 

 Interest estimates should be in the same ballpark if the same rate is specified, but may 
not line up exactly. In Capital Plan, interest is computed assuming monthly 
compounding at the rate provided, and that both contributions and expenses are 
evenly distributed throughout the year. Some reserve studies assume all expenses 
come at the end of the year – which is patently absurd and will yield an unrealistically 
optimistic estimate of interest earned. 

 The biggest differences are likely in Fully Funded amounts and % Funded. These 
serve as a useful guide, but have no impact on how much money you actually have 
from year to year. Capital Plan offers several options for computing a fully funded 
figure as described in detail in the Funding Style section of the manual. Some are 

 Reserve studies may make surprising assumptions about inflation rates. Some choose to compound 6

inflation monthly instead of annually which will lead to differences in future price estimates.
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more conservative than others, so choose one that you believe is appropriate for your 
needs and don’t worry if it’s not precisely how your reserve analyst chooses to 
compute theirs. 
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